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Introduction 
 
Welcome to PhotoStudio!  PhotoStudio is an advanced image editing program.  That sounds 
scary, but don’t worry—it’s designed for use by general consumers just like you.  You don’t need 
to be an expert artist to enhance your photos or create neat graphic designs.  It’ll help if you 
read through this manual completely while you’re using the program.  The knowledge here is 
insightful, but it’s best absorbed if you’re working hands-on.  Plus, it’s more fun that way! 
 
This manual was written with the assumption that you understand basic Macintosh commands 
and features.  Again—don’t get scared off just yet…  If you’re new to computers or haven’t quite 
grasped what “files,” “folders,” “directories,” “saving files” and whatnot mean, don’t worry.  
Viewing, enhancing, and sharing digital photos isn’t something that’s exclusively for computer 
savvy types… anyone can do it.  You’ll just need to have a little more patience.  Take your time 
and you’ll be just fine.  You’ll learn plenty, and a little knowledge never hurt anyone. 
 
We know, you want to get started working on your photos.  However, it’s fairly important that 
you understand some basic things.  At the very least, it’s important that you learn about the 
various components that you see when you run the program.  We’ll start by talking about these 
components, called “palettes.”  From there, we’ll talk about the “file browser” and various menu 
options.  The final section will be something of an index of various tips and tricks.  If you’re 
familiar enough with photo editing, feel free to skip back there to find what you need. 
 
Cool Photo Vocabulary 
It’s a good idea to understand these elementary terms.  You’ve probably already heard lots of 
words about computers and such that don’t make sense.  Here’s a small list that may help with 
regards to photo editing.  The definitions here are very broad, but at the very least, you can 
impress some friends by showing off your expanded computer vocabulary: 
 

• Digital photo/image/picture: The words “photo,” “image,” and “picture” can be used 
interchangeably.  Basically, any photo that you have on your computer is considered 
digital.  Once you scan a photo and it becomes a file on your computer—bingo—it’s now 
a digital photo.  The same can be said for documents.  Text files are considered “digital 
documents.”  Once you print them out, they become “hardcopy.”  It works the same way 
with photos.  They’re digital photos on your computer or digital camera until they’re 
printed out, at which point they become “prints” or “posters” or whatever you print them 
out as. 

• Thumbnail: A thumbnail is simply a small version of a photo, mainly used for 
previewing. 

• RGB: This stands for “Red, Green, Blue.”  Your images can basically be separated into 
these three standard “channels.”  You’ll notice that when you use some of the 
enhancement tools in PhotoStudio, you’ll be able to separately modify each of these 
channels.  For example, if the reds in your image are too dull but the greens and blues 
look okay, you can increase the brightness of only the red channel.  The three combined 
make up your entire image.  There are other types of channel configurations such as 
CMYK and HSV, but you’ll primarily be concerned with RGB. 

• Pixels: Pixels are the “unit of measurement” for screens such as your television or 
computer monitor.  Imagine a grid of hundreds or thousands of tiny squares covering 
your monitor.  Each individual square is a pixel.  You’ve probably noticed that when you 
zoom into a picture, it becomes blocky, with rough edges.  This is because you’re getting 
closer and closer to seeing the individual pixels that make up the image. 
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• Resolution: The size of a digital image on your screen is measured in pixels.  Resolution 
is simply the measurement of an image’s width and height.  For example, an image that 
has a resolution of 100 x 100 means that it is 100 pixels high by 100 pixels wide.  A 100 
x 100 image may still look different on different monitors.  This is because your monitor 
has a resolution as well.  Some people have their monitor resolution set at 640 x 480; 
others have it as high as 1600 x 1200!  In general, monitors with a higher resolution will 
make pictures look much smaller than on a monitor with a lower resolution.  Why?  A 
100 x 100 image will take up approximately 1/6 of the screen width of a monitor with a 
resolution of 640 x 480.  By comparison, the image will only take up 1/16 of the screen 
width of a monitor with a resolution of 1600 x1200.  It’s the same image, but because of 
the different screen resolutions of the two monitors, they appear different in size. 

• DPI: This can be a bit confusing, but in principle it’s very simple.  When printing within 
PhotoStudio, the size of the printed image is directly dependent on two things: 
resolution and DPI (dots per inch).  By setting the DPI for a photo, you determine how 
many pixels will be contained in each inch that is printed.  For example, if you have a 
photo that is 1000 x 1000 and print at a DPI of 100, you’ll get a 10” x 10” image.  
Because the image is 1000 pixels high and you’re printing 100 pixels in an inch, you’ll 
have a print that is 10” high.  Here’s the confusing part.  The DPI that you see in 
PhotoStudio that is used to set your print size is not the same as the DPI used to 
describe the capabilities of your printer.  For example, some printers can print at a DPI of 
2000.  This means that for each inch that the printer prints, it will shoot out 2000 
individual dots of ink.  Within the software, DPI refers to pixels printed per inch; with 
respect to your printer, it refers to the number of individual ink dots the cartridge puts on 
the paper within a single inch.  A printer my use several dots of ink to make one single 
pixel of the photo. 

• Image Acquisition Device: An “image acquisition device” is any hardware device that 
you can connect to your computer so you can download, or “acquire” images.  These 
include digital cameras, scanners, and webcams.  It’s basically a fancy term that has 
been adopted to describe these things. 

• Driver: Drivers are actually programs or files that are placed on your computer 
whenever you install a CD that comes with a piece of hardware.  A driver basically tells 
the computer what device you have, and is responsible for transferring data back and 
forth from the device to your computer.  Every piece of hardware you have on your 
computer has a driver.  Your printer, your video card, your modem, your sound card…  
all of these devices have a driver installed on your computer that tell it exactly what the 
device is, what it does, and how it does it.  When you installed your flashy new digital 
camera software, the drivers for the camera were installed as well.  You can acquire 
photos from your devices through PhotoStudio, but the program is basically a spectator 
during the actual download or acquire process.  Whenever you acquire photos, 
PhotoStudio basically sits and waits while the driver for your device goes to work.  If 
you’re having problems downloading/acquiring images, contact the manufacturer of your 
camera (or other hardware device) to see if they have an update.  Most companies have 
their drivers available for free download on their Web site, and update them whenever 
issues arise. 
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Palettes 
 
“Palettes” are sections of the program desktop that can be moved around or hidden so that your 
work area looks and feels the way you want.  Each different palette has a different set of 
information that will help you when you work with your photos.  Some people prefer to have 
every single option and button available at all times.  Other people like having as much free 
space as possible to see their images.  You can freely move each of these components, or hide 
them completely when you don’t need them. 
 
Here’s a list of the available palettes and moveable components of the PhotoStudio desktop: 

 
• The Quick Access Bar 
• The Tools Palette 
• The Tool Options Palette 
• The Layers Palette 
• The Navigation Palette 
• The Information Palette 
 

The Quick Access Bar 
 
The Quick Access Bar contains buttons that serve as shortcuts to some of the most common 
functions and options that PhotoStudio offers.  As you move your mouse over the icons, a pop-
up with the button name will appear.  Not all of the buttons will be available at all times.  
Sometimes you’ll need to have an image open in order for a button to become active.  Depending 
on the image properties, some options may be unavailable as well. 
 
Here’s a list of what you’ll find on the Quick Access Bar: 
 

 
New: Click this button to create a new, blank image.  You can define all the characteristics about 
the new image, including the data format, size, and resolution.  Basically, clicking this button 
creates a blank canvas for you to work on.  The color of the canvas is dependent on the colors 
selected in the Tools Palette.  This button is a shortcut to the “New” command under the File 
menu. 
 

 
Open: Clicking here opens the standard Open window.  From here you can search your system 
for any image file to be displayed within the program.  This button is a shortcut to the “Open” 
command under the File menu. 
 

 
Browser: The Browser offers a “tree view” of the files on your system, as well as your ArcSoft 
albums.  The Browser and albums are discussed further in their own section.  You can also open 
the Browser by accessing the “Open Browser” command under the File menu. 
 

 
Acquire: Use this button to run the driver for your selected image acquisition device.  What’s 
that mean?  Basically, click this button when you want to scan a picture, take a snapshot with 
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your webcam, or download a photo from your digital camera.  Because you may have one or 
more of these types of devices (for example, you may have a scanner and a digital camera 
connected), you’ll need to choose which device you want to use when this button is clicked.  Go 
to the File menu and choose “Select Source.”  A window will appear with a list of every 
compatible driver on your system.  Select the one you want, then click this icon to run the driver 
and acquire your photo. 
 

 
Save: This is a pretty standard function.  Basically, click it to save your work.  You probably 
know this already, but power outages, computer crashes, and other accidents seem to creep up 
at the worst possible time.  Don’t learn the hard way—save your work often! 
  
When saving a new image, the standard “Save As” window will appear.  You’ll need to do three 
things: 

 
1. Give the file a name: Type in a file name that’s descriptive of the actual image, or at 

the very least, easy to remember. 
2. Choose the file format: The program supports a wide range of file formats.  Choose 

the one that’s the most convenient for you.  Different formats may have additional save 
options, so make sure you know enough about the format you want before choosing it. 

3. Choose the save location: Navigate through your system to select the folder in which 
you want the image saved.  It’s generally a good idea to manage your files by grouping 
them together.  Keep all of your photos in one location and create subfolders to organize 
them into different categories. 

 

 
Print: One of the main reasons you’re using PhotoStudio is to print your photos.  This button 
provides a shortcut to the Print Screen.  You can also get to the Print Screen by choosing “Print” 
from the File menu.  The Print Setup button lets you view and configure your printer settings. 
 
There are several things you can do on the Print Screen: 

 
1. Positioning the photo: Click and drag the photo to position it anywhere on the page.  

Check the “Center Photo” checkbox to re-center it. 
2. Adjusting the photo size: Use the slider to adjust the width/height of the image.  

Notice the “Output” value above the slider.  Here’s where your knowledge of resolution 
and DPI will come in handy (you remember the Introduction, right?).  For good quality 
prints, you probably shouldn’t print below 200 DPI.  Use the slider to find a good 
compromise between size and quality.  If you find that you inevitably need to continually 
shrink your images to get them to print out at a good quality, consider maximizing the 
resolution of your digital camera or scanning at a higher DPI with your scanner. 

3. Adding a title: Check the “Add Title” box to include text header with your print.  When 
the box is checked, you’ll see a box appear on the print preview that says “Double click 
to edit text.”  Double-click in this box to enter in a title.  You’ll be able to choose the font, 
size, and style of the text.  When you’re done, you can click and drag the text box to any 
location on the page.  Check the “Center Title” box to move it to the center of the 
vertical axis. 

4. Adding a frame: Check the “Add Frame” box to include a black outline around your 
print.  You may want one added for stylistic purposes, or just as a guideline to use if you 
happen to be cutting the picture out. 
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Cut, Copy, and Paste: These next three buttons are very closely related.  Make sure to read all 
three.  Though these are fairly common operations throughout many Macintosh programs, we’ll 
talk about how they could be used in photo editing. 
 

 
Cut: When you “cut” a part of a photo (or an entire photo), the area is removed and placed into 
“Clipboard memory.”  What this means is the image data is stored so you can then “paste” the 
part you cut into another location.  Clipboard memory isn’t infinite, nor can image data remain 
there forever.  It’s best to use the Paste option soon after using the Cut option.  You can perform 
the command by clicking this button, or choosing “Cut” from the Edit menu. 
 

 
Copy: This works similarly to the Cut command, but instead of removing the image data, it 
simply places a copy of it into Clipboard memory.  You can access the Copy command by clicking 
this button or choosing “Copy” from the Edit menu. 
 

 
Paste: When you use this command, any image data stored in Clipboard memory is pasted onto 
the current image.  Click this button to paste, or choose “Paste” from the Edit menu. 
 
These three tools (Cut, Copy, and Paste) are extremely useful.  For example, you can “cut” or 
“copy” a section of an image, then “paste” it in another location, or on an entirely different 
image. 
 

 
Undo: You’re bound to make mistakes when editing your photo.  Or, you may end up applying 
effects that you end up not liking once you see the end result.  The Undo command is just what 
you need.  With a single click, you can reverse the last action you’ve performed.  You can 
perform this command multiple times.  The exact amount is dependent on you.  Go to the 
PhotoStudio menu and select “Preferences.”  You’ll see in the Preferences Window that you can 
modify the “Undo level.”  It can be set as high as 99.  This means that you can perform 99 
functions, then undo each one individually. 
 

 
Redo: This command has become a necessary complement to the Undo command.  While the 
Undo command reverses a function, the Redo command re-implements a command that was 
undone.  For example, lets say that you raised the brightness and contrast of a photo.  You’re 
not entirely sure that you like the way it looks, so you click the Undo button.  Now let’s say that 
you’d like to see how it looked with the enhancement, but you forgot exactly what values you 
used to modify the picture.  No problem—just click the Redo button.  In effect, it will “undo” the 
Undo command. 
 
Using the Undo/Redo commands are great for “going back and forth in time” to see your image 
at various stages of development.  You can go back and forth to see the various changes that 
you’ve made. 



 

PhotoStudio Manual 
 

 - 7 - 

 
Auto Enhance: This command opens a window that displays a slider and a before/after 
preview.  Drag the slider to adjust the intensity of the auto enhance effect.  Basically, it’s a fast 
and simple way to enhance your photo with some mild effects. 
 

 
Effect Browser: A variety of effects can be previewed and applied to a photo using the Effect 
Browser.  At the top of the browser is a pull-down that lets you select the desired enhancement 
or effect. 
 

 
 
Different enhancements/effects will have different options available.  In the sample above, a dull 
picture is being made a bit brighter.  As you can see, you have convenient before/after images so 
you can preview each effect.  Use the zoom buttons (+ and -) to focus on a specific area.  Click 
and drag within the previews to view areas of the image that may not fit in the preview. 
 

 
Stitch: This command lets you “stitch” two photos together into one.  You must have at least 
two images open in order to use this function (unless you want to stitch the same image to 
itself). 

 
1. Choose your images: The “Principal” image is the current image that you have in the 

foreground of the program.  If you have more than one other image open, use the 
Secondary pull-down to select the one you want to stitch to the Principal image. 

2. Choose the stitch type: Use the On pull-down to choose where you want to stitch the 
Secondary image (choose Left, Right, Top, or Bottom). 
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3. Set the blend: Use the Blend slider to adjust the amount of blend you want between 
the stitched images.  Choose “100” for the smoothest blend. 

4. Set the stitch points: The stitch points are the spots where the two images will be 
merged.  All you need to do is click on either image to set the point.  Use the zoom tools 
so you can set these points precisely.  Once they’re set, click the Adjust button.  The 
program will automatically attempt to match the points of both images to a similar 
location. 

5. When you’re ready, click OK.  The images will be stitched together as a new image. 
 

 
Play Macro: A macro is a custom set of commands that can be applied with a single click.  Don’t 
worry—it’s not as complicated as it sounds, and once you learn how to use them, macros are 
invaluable timesavers.  Before you can use a macro, you’ll need to create one first.  We’ll make 
one that’s really basic.  Let’s say that you have an entire batch of images that look overly dark.  
You find that you keep increasing the brightness of each photo by the same amount.  Instead of 
selecting the Brightness and Contrast enhancement and adjusting the brightness slider for each 
photo, you can create a macro and apply the brightness enhancement to each photo with a 
single click.  Here’s how to do it: 
 

1. Open an image. 
2. Go to Enhance and select “Brightness and Contrast.”  Adjust the brightness and/or 

contrast to your liking and click OK. 
3. Go to Edit and choose “Select Macro.”  The Macro Window will appear. 
 

 
 
4. The command you did (“Brightness and Contrast”) is displayed on the right.  The macro 

is new, and currently labeled “Unsaved Macro.”  You can type in a unique name for it.  
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We typed in “Brightness.”  After you’ve typed in a name, click Save.  Your macro is now 
saved. 

5. Highlight your macro on the list, then click Select.  Now, whenever you click the Play 
Macro button on the Quick Access Bar, the commands under the macro (in this case, a 
“Brightness and Contrast” enhancement) will be used on the open image. 

 
You can create numerous macros.  Only one can be assigned to the Play Macro button at any 
given time.  So, remember to open the Macro Window whenever you want to change macros. 
 
One other note about the Macro Window…  The Record button can also be used to create a 
macro.  Basically, after you click it, the Macro Window will disappear so you can perform the 
commands that you want to use in the macro.  When you’re done, the commands you’ve 
performed will appear in the “Commands in macro” list the next time you open the Macro 
Window.  You can then save the commands as a new macro. 
 
Play around with PhotoStudio for a while to see if you find yourself performing the same 
commands over and over.  If you are, a macro can be just the thing you need to save you time.  
Note that not all functions can be used in a macro.   
 

 
Help: Clicking here launches the program Help file. 
 
 
The Tools Palette 
 
PhotoStudio has a wide selection of tools that will help you create, edit, and enhance images.  
These tools are located on the Tools Palette.  Some tools let you select specific areas on an 
image.  Other tools let you modify image color.  There are a wide variety of tools.  To select a 
specific tool, simply click it. 
 
Here’s a complete list of tools available on the Tools Palette.  We’ll start with the color selection 
area at the bottom of the palette, then we’ll go through the tools in order from top to bottom.  
Some of the tools are affected by the colors, so it’s probably best if we discuss those first. 
 
The Tools Palette can be moved around the screen by clicking and dragging the title bar.  It’s 
probably a good idea to not hide this palette either.  You’ll be using it a lot so you may as well 
keep it conveniently in sight.
 

 
 
Active and Alternative Swatch: The Active Swatch is the currently selected color.  This color 
overlaps the secondary color, called the Alternative Swatch.  The Active Swatch is the color that 
will appear whenever you use the Draw Tool, or any other tool that requires a selected color.  
Think of the Alternative Swatch as an “on-hand” color.  Often you’ll find that you’ll need to switch 
between two colors, so two are made available for easy access.  Further, there are other tools 
that require the use of both swatches. 
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Color Grid: When you click button, a grid of colors will appear.  Click on a color to select it as 
the Active Swatch.  The available colors are dependent on the type of image you are viewing.  
For example, if you are viewing a grayscale image, the colors will be black, white, and a 
multitude of grays.  If you’re viewing a color image, a wide variety of colors will be available. 
 
Color Palette: This is similar to the Color Grid, except it offers a wider blend of colors. 
 
Color Picker: The most complex of all color selection options, the Color Picker offers numerous 
palettes and sliders for choosing and creating colors.  While it may seem difficult, you’ll probably 
want to play around and see what kind of colors you can create. 
 

 
Select Tool: This tool allows you to select a certain section of an image.  You may want to edit 
only a part of an image, or crop out a specific area; this tool will help you choose that area.   
 
Once you’ve selected the desired shape (see below), click and drag on the image.  You’ll notice a 
transparent shape appear.  The shape will vary depending on the option you’ve chosen (the 
default is Rectangle Select). 
 
Don’t worry about making your selected area perfect the first time.  If you make a mistake, just 
click the Undo Tool on the Quick Access Bar and start over.  Or, if your selected area is roughly 
the size you want but not in the right place, click and drag within the area to move the entire 
selection shape. 
 

Select Tool Options: The following appears in the Tool Options Palette when using the 
Select Tool: 

 
• Use the pull-down to select the shape of the Select Tool (Rectangle, Circle, etc.). 
• New: Creates a new selection whenever you click, automatically removing any other 

selection. 
Add: Lets you add to the currently selected area. 
Subtract: Any area that you select will be removed from the currently selected area. 

• Draw from Center: typically, clicking and dragging from one corner of the area to 
another create a selected area.  Checking this box creates the selected area from the 
inside out; as you click and drag, the shape will appear from the center and expand 
outward. 

• Size Fixed: Creates a selected area according to the width and height that you specify 
(in pixels). 

 

 
Move Tool: This tool lets you move areas that have been enclosed by the Select Tool.  Click and 
drag within the selected area to move any part of the image that is enclosed by the area.  If no 
specific area is selected, the entire image or layer will be moved. 
 

Move Tool Options: The following appears in the Tool Options Palette when using the 
Move Tool: 

 
• Retain Original: Moves the selected area to the new location, but also remains in the 

original spot. 
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Freehand Select Tool: This tool lets you select a unique area.  You can use this tool in a few 
different ways.  As you click and drag on the image, a “selection line” will appear wherever you 
drag the mouse.  You can move the mouse in any direction and the selection line will follow.  To 
close off your selection, simply double-click.  The end of the selection line will automatically 
connect to the beginning, enclosing the selection area.  You can also make selections by clicking 
in a ‘connect-the-dots” fashion; click once to set a “selection point.”  Then, move your mouse to 
another location and click (thus making a second selection point).  You’ll notice a straight line 
appear from point to point.  You can then move your mouse to another spot.  Click the mouse 
again, and you’ll notice a line extend from the second selection point to the third.  Continue 
doing this until you’ve created the shape you want.  To close the selection, double-click.  A line 
will be drawn from the last point to the first, enclosing the selection. 
 

Freehand Select Tool Options: The following appears in the Tool Options Palette when 
using the Freehand Select Tool: 

 
• New: Creates a new selection whenever you click, automatically removing any other 

selection. 
Add: Lets you add to the currently selected area. 
Subtract: Any area that you select will be removed from the currently selected area. 

 

 
Magic Wand Tool: This tool automatically creates a selected area based on color similarity.  For 
example, if you’d like to select the entire sky of a specific image in order to alter its color, you’d 
use this tool.  Simply click on the desired area, and the program will automatically select the 
desired area if the color is similar.  You can easily adjust the sensitivity of the tool if it ends up 
selecting too much or too little. 
 

Magic Wand Options: The following appears in the Tool Options Palette when using the 
Magic Wand Tool: 

 
• New: Creates a new selection whenever you click, automatically removing any other 

selection. 
Add: Lets you add to the currently selected area. 
Subtract: Any area that you select will be removed from the currently selected area. 

• Contiguous Area Only: When this box is checked, the Magic Wand will only select a 
continuous area (one without gaps).  Unchecking this box will allow the tool to select 
areas based on color throughout the entire image.  This means that if you click on a blue 
area, every single blue area on the image will be selected. 

• Tolerance: Use these sliders to adjust the sensitivity of the tool.  The lower the 
tolerance, the “pickier” the tool is in selecting areas of similar color.  For example, if you 
set the tolerance for the color channels (Red, Green, Blue) to a very low value, chances 
are the tool won’t select a very large area.  The higher the tolerance, the more forgiving 
the tool is.  It’s more likely to select a broader area by treating the various shades of a 
specific color as one. 

 

 
Zoom Tool: Use this tool to zoom in/out while editing an image.  Choose either “Zoom In” or 
“Zoom Out” on the Tool Options Palette. 
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Pan Tool: If your image is being viewed in a way that it doesn’t fit entirely on the screen, use 
this tool.  After you select it, you can click and drag on your image to focus on different areas.  It 
works similarly to using the Navigation Palette, or the scrollers that appear around the image 
window when it can’t be completely viewed. 
 
A note on drawing tools:  Most drawing tools let you choose a specific “brush size.”  Think of this 
as the tip of your drawing instrument.  You can choose large or small sizes.  You can also add 
your own brush or pattern by clicking the Add button.  You can delete brushes you no longer 
need by selecting one and clicking the Delete button.  All of this is done in the Tool Options 
Palette when working with the specific tool. 
 

 
Pen Tool: Click this tool, then click and draw on your image to simulate drawing on it with a 
pen. 
 

 
Paintbrush Tool: Works the same as the Pen Tool, but it mimics a paintbrush instead. 
 

 
Spraypaint Tool: Simulates graffiti by turning your mouse into a can of spraypaint. 
 

 
Eraser Tool: This tool simulates an eraser.  Click and drag to erase parts of an image. 
 

 
Smudge Tool: Use this tool to smudge or smear areas of an image.  Click and drag to simulate 
the smudging of wet paint. 
 

 
Clone Tool: This is a fun tool that can be used for a variety of purposes.  What it does is copies 
one area of a photo to another.  The copied area is defined by how you “paint.”  Here’s how to 
use the Clone Tool: 
 

1. Select the “clone source.”  The clone source is the area that you’re going to replicate 
elsewhere.  You only need to pick one point.  To mark your clone source, hold down the 
Shift key and click the mouse. 

2. Start cloning!  Now that your clone source is set, you can clone it on the same image, or 
a completely different one.  To clone, simply click and drag.  You’ll begin painting the 
area of your clone source in the new location.  Once you release the mouse button, the 
cloning will end.  If you click and drag again, the clone process will begin again. 

 
Clone Tool Options: The following appears in the Tool Options Palette when using the 
Clone Tool: 

 
• Use Clipboard: Checking this box uses any image data that is stored in the Windows 

Clipboard as the clone source. 
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• Brush Size: Use this slider to adjust the size of the cloned area that appears as you 
paint. 

• Transparency: Use this slider to adjust the transparency of the effect.  The higher the 
Transparency, the more transparent the effect. 

 

 
Bucket Fill: Fills the selected area with a specific color.  The Tool Options Palette will display the 
following: 
 

• Transparency: The higher the Transparency, the more transparent the effect. 
• Color Similarity: The higher this slider is set, the more forgiving the tool is in 

choosing which areas to include in the fill. 
 

 
Pattern Fill: Fills the selected area with a pattern of your choice.  The Tool Options Palette will 
display the following: 

 
• Use the pull-down to select how the pattern will be filled: Aligned, Brick, or Mirror. 

Add – Click this button to add a new pattern.  A window will appear, allowing you to 
browse your computer to select an image to use as a pattern. 
Delete – Click this button to delete a pattern that you no longer need. 

• Fill Texture Only: Check this box if you would like to fill the area with the selected 
pattern, but as a translucent layer (no color will be added). 

• Use Clipboard: Checking this box uses any image data that is stored in the 
Windows Clipboard as the pattern. 

• Transparency: The higher the Transparency, the more transparent the effect. 
• Mirror, Aligned, Brick: Determines the pattern in which the pattern will fill. 

 

 
Text Tool: Use this tool to add text to an image.  When you add text, it will be created on a new 
layer. 
 

Text Tool Options: The following appears in the Tool Options Palette when using the Text 
Tool: 

 
• Standard text editing commands are available here, including font, size, style, etc. 
• New: Click this button to create a new text layer.  You can add multiple layers of text 

and modify each one independently. 
• Anti-Alias: Check this box to produce text with smooth edges. 
• Wrap: Check this box if you would like the text to “wrap” once it reaches the right 

border of the image.  The text will then automatically skip down a line. 
• Shadow: Check this box to add a shadow to your text.  Click the Shadow button to 

adjust the shadow properties: 
 
• The preview area shows you how the shadow will appear beneath your text.  Click 

and drag within the preview area to reposition the show and use the sliders to give it 
the look you want. 
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Brightness Tool: With this tool, you can either lighten or darken areas of an image.  This tool 
works similarly to the draw tool, except that instead of adding color, it lightens or darkens.  In 
the Tool Options Palette, select either Lighten or Darken.  If you want to adjust the brightness of 
the entire image, choose “Brightness and Contrast” from the Enhance menu.  Only use this tool if 
you want to manually touch up a specific area of an image. 
 

 
Sharpen/Blur Tool: This tool works similarly to the Brightness and Draw Tool, but instead is 
used to make images look sharper or blurrier.  In the Tool Options Palette, select either Sharpen 
or Blur.  Use this tool to touch up areas that are too rough or too blurry.  If you want to apply a 
blur or sharpen effect over the entire image, it’s probably best to use one of the “Sharpen Filters” 
under the Enhance menu. 
 

 
Stamp Tool: Use this tool to add a colored “stamp” to your image.  Choose the stamp shape 
you want, then click and drag on your image to form the stamped area.  As you click and drag, 
you’ll notice a selection box will form.  When you release the mouse button, the stamp will 
appear in that selected area. 
 

Stamp Tool Options: The following appears in the Tool Options Palette when using the 
Stamp Tool: 

 
• Select your stamp shape from any of the supplied templates. 

Add – Click this button to add a new stamp shape.  A window will appear, allowing you 
to browse your computer to select an image to use as a stamp. 
Delete – Click this button to delete a stamp that you no longer need. 

• Lowering the Opacity slider will make your stamp more transparent. 
• Keep Aspect Ratio: Check this box if you want your stamp area to remain in proportion 

as you drag your mouse to make it larger or smaller. 
• Default Size: Checking this box creates the stamp area in the exact size of the stamp 

template. 
 

 
Shape Tool: This tool crops your image into a specific shape.  Like the Stamp Tool, you basically 
click and drag to form a window.  When you release the mouse button, your image will be 
cropped within the selected area.  It will be made into the shape that you choose. 
 

Shape Tool Options: The following appears in the Tool Options Palette when using the 
Shape Tool: 

 
• Select your shape from any of the supplied templates. 

Add – Click this button to add a new shape.  A window will appear, allowing you to 
browse your computer to select an image to use as a shape. 
Delete – Click this button to delete a shape that you no longer need. 

• Lowering the Opacity slider will make your shape more transparent. 
• Restrain: Check this box if you want your shape area to remain in proportion as you 

drag your mouse to make it larger or smaller. 
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• Default Size: Checking this box creates the shape area in the exact size of the shape 
template. 

 

 
Gradient Fill Tool: A “gradient fill” will effectively fill your entire image (or selected area) with a 
color blend.  The blend is dependent on the two colors selected at the bottom of the Tools 
Palette; it will begin with the Alternative Swatch and blend into the Active Swatch.  You have 
complete control over the type of blend and transparency of the filled color.  To perform the fill, 
click and drag the mouse over the image.  The distance that you drag the mouse is the distance 
of the blend between the two colors.  For example, lets say you do a linear gradient fill and you 
click and drag a distance of one inch on your image to create the fill.  In that one inch, the 
Alternative Swatch will blend into the Active swatch and fill the entire selected area.  
 

Gradient Fill Tool Options: The following appears in the Tool Options Palette when using 
the Gradient Fill Tool: 

 
• Style: The gradient fill can be made in a variety of ways. Use this pull-down to select the 

pattern of the fill (linear, circular, etc.). 
• Transparency: Raise the Transparency to make the fill more transparent. 
• Frequency: Modify this slider to set the repeat rate of your gradient fill. 
• HVS and RGB: Choose the color channel format that you want to use.  For a direct 

blend between the two selected colors, choose RGB. 
• Transition: Choose Hard or Soft according to your liking. 

 

 
Line Tool: You can create a straight line with this tool.  Simply click and drag the length of the 
line, and one will be created with the specified properties, which can be selected in the Tool 
Options Palette: 
 

• Mode: Choose between Vertical, Horizontal, and Arbitrary.  If you choose Vertical or 
Horizontal, the line will automatically “snap” to the vertical or horizontal position 
regardless of how you drag your mouse when creating the line.  By selecting Arbitrary, 
the starting point of the line will be where you initially click; the end will be where you 
release the mouse button. 

• Line Width: Use this slider to adjust the thickness of the line. 
• Anti-alias: Check this box to create a smoother line.  This effect is particularly 

noticeable when you create an arbitrary line (one that isn’t perfectly vertical or 
horizontal). 

 

 
Transform Tool: This is fun tool that’s basically used to change the size or orientation of a 
selected area.  You can modify an area in a traditional manner by rotating it to any desired 
position, or you can choose a special type of orientation modifier.  Available options include 
Rotate, Resize, Skew, Arbitrary, and Perspective.  The best way to describe these options is to 
say that they’re basically used to distort your image in unusual ways.  They generally shouldn’t 
be used to fix image problems and such.  Rather, use these to create unique image designs.  You 
can also use this tool to rotate a specific area of a photo.  Note that the Transform tool is best 
used after you’ve selected a specific area using the Select Tool. 
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Eyedropper Tool: This tool “sucks” up any color and makes it the selected color (Active 
Swatch).  After you click this button, move your mouse over any color within an image.  When 
you click, that color will become the Active Swatch.  Options in the Tool Options Palette include 
choosing between RGB and HSV color, and the pixel area.  Set the pixel area higher (up to 10) to 
“suck up” a larger area.  The color value will then be the average of all of the colors selected. 
 

 
Crop Tool: Click this button once you’ve selected a crop area with a Select Tool.  Everything 
outside of the selected area will be removed from the image.  You can also execute the crop 
function by choosing “Crop” from the Edit menu. 
 

 
Trash Can Tool: Click this button to remove any selected area made with the Select Tool.  
 
 
Tool Options Palette 
 
You’ve already learned the bulk about what this palette contains.  The information displayed in 
this palette is directly dependent to the tool selected in the Tools Palette.  For example, when 
you select the Pen Tool, this palette will display the various options that are available, such as 
the brush size and transparency.  When you choose the Text Tool, the palette will display various 
text options.  All of the options available here are described with each related tool in the Tools 
Palette section. 
 
 
The Layers Palette 
 
Layers allow you to “stack” multiple image components within a single file.  This means you can 
copy/paste multiple images on top of each other, then adjust their transparency to make them 
look as if they’re blended together.  But that’s just one example.  With layers, you can create 
awesome graphic images that include both text and photos.  Since each layer is independent, 
you can edit and enhance each one without affecting others. 
 
The easiest way to experience the benefits of layers is to add text to an image.  You’ll notice that 
when you do, the Layers Palette will show a new layer.  Even though it appears that the text and 
image are one, they are actually independent components.  You can then continue to edit the 
image without affecting the text. If you want, you could even go back and change the text that 
you’ve written! 
 
You can save your image and all of its layers by saving in the PhotoStudio File format.  If you 
save in any other format, you will lose all layer information. 
The main thing when working with layers is to make sure you’re on the right layer when you 
continue editing.  To select a layer, simply click it.  When you apply paint or use other tools from 
the Tools Palette, they will generally only affect the layer that you have selected.  Let’s look at 
the additional layer tools: 
 
 



 

PhotoStudio Manual 
 

 - 17 - 

 
New Layer: Click this button to create a new, blank layer. 
 

 
Copy Layer: Clicking this button will copy the current layer into Clipboard memory.  You can 
then paste the layer onto another photo. 
 

 
Paste Layer: Clicking this button pastes the layer data from Clipboard memory onto the current 
image. 
 

 
Delete Layer: You can delete the currently selected layer by clicking this button. 
 

 
Merge All Layers: Click this button to combine all layers into one single layer.  Since there will 
only be one layer left, you won’t be able to edit each individual component—because there will 
be no individual components!  All layer data will be merged into one. 
 

 
Visible Layer: Clicking this button hides/unhides the selected layer.  When you hide the layer, it 
will disappear from view.  When you’re working with several layers, it may be better to hide some 
of them when you need to concentrate on one in particular. 
 

 
Restricted Layer: By restricting a layer, you limit the area that can be affected by edits to those 
that contain color.  It’s best to illustrate this idea. 
 

Restricted Layer: 

 
As you can see, this is a text layer that was scribbled over in blue.  Because the layer is 
restricted, the blue paint was restricted only to areas on the layer that had image data, in 
this case, text.

 
Unrestricted Layer: 

 
Here you’ll notice that the blue paint overlaps the entire layer, even areas that are blank.  
This is the result of the layer being unrestricted.
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Double-clicking a layer also lets you give the layer a name and adjust the opacity of the layer.  By 
making a layer translucent, you can create neat effects by stacking multiple images that look 
blended together. 
 
Note: You can go back at any time to edit text on a text layer as long as you do not modify the 
layer in any other way.  If you paint over or distort the text, it ceases to be editable. 
 
 
Navigation Palette 
 
This palette provides you with a simple way to zoom in/out on a photo. Move the slider to the 
right to zoom in on your image; slide it to the left to zoom out.  When zoomed in, a blue box will 
appear in the preview.  Click and drag the box to move about to other areas of your photo that 
you can’t see because of the image size (if the image is too big, it won’t be fully visible on the 
screen, so moving the blue box in the preview of the Navigation Palette will adjust the point of 
focus).  Click the 1:1 button to display the image in its actual, full size.  Navigating with the 
Navigation Palette works similarly to the Pan Tool as described in the Tools Palette section. 
 
 
Information Palette 
 
This bar displays various information while you’re using the program.  In general, it lists the 
image view ratio and miscellaneous tool tips.  It takes up very little space so it shouldn’t be an 
inconvenience. 
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The Browser & ArcSoft Albums 
 
The Browser offers a great way to locate and open images.  It offers two view modes: Folder 
View and Album View. 
 
Folder View 
 
If you’re familiar with browsing your computer, you won’t have any problem understanding 
Folder View.  It works basically the same way.  A tree view is available, which lets you easily 
navigate to any location on your computer.  When you click on a folder, the images within that 
folder will appear as thumbnails.  You can then double-click a thumbnail to open the image. 
 
The following tools are available when in Folder View: 
 

 
Acquire: Lets you acquire a photo from a connected digital device.  This function was discussed 
in an earlier section. 
 

 
Sort: Lets you sort the thumbnails in a variety of ways, including file name, date, size, etc. 
 

 
Delete: If you click this button, the file will be permanently deleted.  This button functions 
differently in Album View. 
 

 
Print: The Print option here lets you create a contact sheet by printing the images as 
thumbnails.  You can choose your layout options.  This feature is great for making catalog 
sheets. 
 

 
Help: Launches the PhotoStudio Help file. 
 
 
Album View 
 
The number one thing you need to know about albums is that they do not store your images.  
Rather, they store shortcuts to them.  You may notice that when you install programs on your 
computer, shortcuts to run the programs appear on your desktop.  You can delete the shortcuts 
without deleting the actual programs.  Albums work the same way.  They’re basically catalogs of 
links to your actual image files. 
 
Albums can be very useful if you’re one to categorize your photos.  You can have photos stored 
in various locations on your computer all linked to a single album.  You can give your albums 
unique names so you exactly what they contain.  Here are the additional commands that are 
available when in Album View: 
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Add: When you click this button, a standard Open window will appear.  You can browse your 
computer for images to link to the album.  Any images that you “add” will appear as thumbnails 
within the album. 
 

 
Find: Lets you look for images using a variety of search criteria.  You can then link the files 
found in search result to a new album (albums will be described in a bit). 
 

 
Batch: This command lets you perform a macro (remember those?) to your entire album.  Well, 
you actually have the option of applying the macro to every image, or only those that you select.  
You can select multiple images by holding the Control key and single-clicking them.  You can also 
choose what to do with the files once they’ve been modified.  You can have them appear on the 
PhotoStudio desktop (for further editing maybe?), or you can just have them saved (so they 
overwrite the old version, before the macro was applied).  Alternately, you can have them saved 
as new files. 
 

 
Delete: When this function is used in Album View, you will be given the choice of deleting the 
thumbnail link only, or deleting the link and the actual image file.  Remember, albums don’t store 
your files; they only reference where they’re stored with a shortcut (that being an image 
thumbnail).  So, the Delete command here lets you delete only the shortcut, or the shortcut and 
the actual file. 
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Menus 
 
Along the top of the program desktop you’ll see what looks like a standard menu bar.  You’re 
probably familiar with menu bars from using other applications.  There are several options here, 
but luckily, many of them are available on one or more palettes.  So, since we discussed the 
various palettes already, you won’t need to re-read information on many of the commands 
available here in the menu bar. 
 
PhotoStudio Menu 
 
This menu contains standard options found in most Macintosh programs (Show, Hide, Quit, etc.), 
as well the Preferences window.  The Preferences Window contains various options for the 
program.  The Undo level can be increased all the way to 99.  However, the higher this number, 
the more resources are required.  Basically, your computer will need to remember each step that 
you take so it can undo it if necessary.  Keep this value relatively low (the default should be fine), 
then increase it if you find that you need to go undo further than you’re allowed.  The 
Transparency Background is basically the color that will appear when there is no image data in a 
layer.  For example, when you have a text layer, the layer is basically blank, except for the text.  
The blankness can either be white, or a checkerboard pattern. 
 
 
File Menu 
 
The following commands in the File menu have already been discussed in other sections of this 
manual: New, Open, Save, Save As, Open Browser, Acquire, Select Source, Print, and Printer 
Setup.  Here are the other commands: 

 
• Restore: Use this command if you want to get rid of any and all changes that you’ve 

done to a photo.  Basically, it returns your photo to the state it was in when it was last 
saved. 

• Close: Closes your photo.  Pretty simple, right?  Just know that you’ll be asked to save 
your photo if you’ve made any changes to it. 

• Slide Show: Creates a slide show of the photos within a specific album.  You can set 
the display time for each slide, loop the slide show continually, and add cool transition 
effects between each slide.  Press Esc to exit the slide show. 

• Import: This command lets you grab images from removable devices such as hard 
drives and miscellaneous connected media.  What’s special about this is the ability you 
have to set a wide variety of options.  For example, you can select the location where all 
of the imported images will be stored on your system.  Further, you can rename all of 
the images as they’re imported.  There’s a variety of other options that are all available 
in the Import Window. 

• Capture: This command lets you take a screen capture.  You can either take the 
snapshot immediately, or have it automatically capture after a few seconds (so you have 
time to prepare the screen.  You can also choose to have PhotoStudio hide while the 
snapshot is being taken. 
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Edit Menu 
 
You’ve already learned about the following commands in other sections of this manual: Undo, 
Redo, Cut, Copy, Paste, Crop, Select Macro, and Play Macro.  Here’re the rest of the commands 
in the Edit menu: 
 

• Clear: This command removes all color from a selected area.  If you use this command 
without any specific area selected, the entire image or layer will be wiped clean.  Don’t 
worry—if you do this on accident, you can always use the Undo command. 

• Fill Color: You can cover an entire area with a single color with this command.  The 
color of the Active Swatch will be used to fill the area.  The cool thing is that you can 
adjust the transparency of the fill.  For example, you can add a red (or any other color) 
tint or haze over your image.  Choose red for the Active Swatch, then use the Fill Color 
command.  Lower the transparency about halfway and you’ll see a translucent haze 
applied to the selected area. 

• Rotate: Use this command to rotate your image.  You can enter in the specific amount 
of degrees, or click and drag the corners of the preview that appears. 

• Orientation: This command can be used to rotate and/or flip your image in a number of 
ways.  Previews are available; simply click the one you want.  You can choose to alter 
the entire image or only a specific layer. 

• Add Border: When you add a border, blank space is added around the edges of your 
photo.  You can specify the amount (in pixels) that is added to each side. 

• Image Size: Use this command to resize your entire image.  You can go about doing 
this in a few different ways.  The easiest way to do it is to change the size by entering a 
new percentage.  The percentage is related to the current image size.  By default, this 
value is 100 (for the width and the height).  This means the image is 100% of its size.  
You can increase or decrease the percentage to get the size you want.  For example, if 
you change the percentage to 50, the image will shrink to ½ its size.  If you increase the 
percentage to 200, the image will double in size.  Alternately, you can enter in the new 
size in terms of specific pixels for the width and/or height.  You may notice that when 
you change one value, the other one changes automatically as well.  This is because the 
Keep Aspect Ratio box is checked.  You will rarely want to uncheck this box.  What it 
does is keep your image in proportion, so when you increase or decrease the width or 
height, it automatically adjusts the other parameter to keep the ratio the same.  For 
example, if you were to change the width without changing the height, the image would 
appear stretched horizontally.  Maintaining the aspect ratio prevents this from happening.  
The resolution value directly affects the default print size.  If you divide the width or 
height by the resolution, you’ll get the default print size in inches.  Example: With a width 
and height of 1000 pixels and a resolution of 200 DPI, the default print size will be 5” x 
5”.  Remember though that you can change the print size directly from the print screen. 

 
You can convert images into the following formats: 
 

• 8-bit Grayscale 
• 16-bit Grayscale 
• 24-bit RGB 
• 48-bit RGB 

 
Typically, most images will be 24-bit RGB.  If you just want black and white images and are 
concerned about having small file sizes, you may want to convert your color image to a grayscale 
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one.  Since the available palette of colors is reduced, so is the file size.  48-bit images are high-
quality images.  You may not notice too much of a difference though, because 24-bit images 
generally are good enough to make quality prints.  Note that not all of the editing options in 
PhotoStudio are active when working with a 48-bit image. 
 
You can also separate an image into various color channels.  Remember our discussions so far on 
RGB images?  Well, you can separate your images into each color channel, red, green, and blue.  
New images will be created for each channel. 
 
Now you know that you can separate an image into distinctive color channels, and you’re 
probably guessing that you can also combine them.  Well, good guess!  When you combine 
images, you must select which image will be used for each respective channel. 
 
Why would you want to separate/combine a photo?  Well, if you don’t know, the chances are you 
probably won’t ever need to do this type of operation.  Still, to satisfy your curiosity, if you have 
each channel as a separate file, you could manipulate each one exclusively and then recombine 
them.  We suggest you don’t do this unless you have a particular reason for doing so.  Oh, and 
not only can you separate/combine in the RGB format.  You can also do it in CMYK, HSV, and 
YIQ. 
 
 
Select Menu 
 
For the most part, the Select menu provides commands that alter selected areas.  By “selected 
areas” we mean any area selected with the Select Tool, Freehand Select Tool, or Magic Wand. 

 
• All: Use this command if you want to select the entire image or layer. 
• Invert: Selects all unselected areas, and deselects all selected areas.  For example, if 

you select a rectangular area and then use this command, everything outside the 
rectangle will be selected as opposed to inside. 

• None: Deselects everything. 
• Border: Adds a border around selected areas.  The selected area then becomes the area 

between the original area and the border.  It’s best to illustrate this: 
 

 
 

• Expand: Extends the area covered by a selection.  You can control the amount that it 
expands. 

• Smooth: This command can be particularly useful when there are selected areas that 
aren’t smooth due to extreme color variances when the Magic Wand is used.  What it 
does is rounds sharp areas of a selected area. 
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Layer Menu 
 
Many of the options here have been discussed in the Layers Palette section.  You already know 
about the New, Delete, Merge All, and Properties options (double-click a layer to see the 
properties).  Here are some other layer options: 

 
• Merge Selected: Combines only those layers that you’ve selected.  Hold the Control key 

on your keyboard and single-click the layers you want to select. 
• Merge Down: This command combines the selected layer with the layer immediately 

below it. 
• Soft Edge: This cool feature fades the edges of your layer.  You can control the 

intensity of the effect with a slider. 
• Add Shadow: Like the Soft Edge effect, this is a neat feature that applies a shadow to 

your layer.  You can control the position and appearance of the shadow. 
  
 
The Enhance and Effects Menus 
 
PhotoStudio includes tons of enhancements and effects.  Most of them don’t differ too much in 
application.  All of them manipulate your images very differently, but the way you go about 
applying the enhancement or effect is pretty similar from one to another.  Here’s a sample.  We’ll 
modify the hue and saturation of a photo: 
 

 
 
As you can see, we altered the hue (shifted the color value for each different color) and 
oversaturated (increased the intensity of each color) the image.  First, we went to the Enhance 
menu and selected “Hue and Saturation.”  Here are the settings that we used: 

 

 
 

It’s pretty simple to apply enhancements.  Basically, all you really need to do is play around with 
the sliders.  The preview windows show you in realtime exactly what the effect does.  You can 
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zoom in/out of the preview windows, and click and drag within them to scroll to various areas of 
your photo. 
  
With effects, it’s just as easy.  And there’s a plethora of them! 
  
Here’s a set of sample enhancements and effects possible with PhotoStudio.  Mind you, this is a 
very small sample.  Because you can tweak most enhancements and effects, the possibilities are 
nearly endless. 
 
Sample PhotoStudio Enhancements and Effects: 
 

 
 
 
View Menu 
 
The View menu lets you select how images are displayed on the screen.  You already know about 
the Zoom Tool, so we won’t discuss the Zoom In/Out options available here.  However, there are 
other important view modes that you need to know about: 
 

• Actual View: This option displays your image in its true, actual size.  Oftentimes when 
you open an image it will be too large to fit entirely on the screen.  PhotoStudio will 
automatically resize it in order to display it fully.  So, if you ever want to see what you 
image actually looks like, choose this command.  Viewing the same image in its actual 
view can still look different on different monitors.  Reach back and remember what we 
talked about regarding pixels and screen resolution.  If you have a 500 x 500 image and 
your monitor has a resolution of 800 x 600, the image will be covering most of the 
screen.  If your monitor resolution is set to 1024 x 768, the image won’t cover so much 
of the display.  It’s all a matter of pixels. 
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• Fit In Window: You’ll notice that images are displayed in their own windows.  This 
command automatically resizes the photo so that it fits entirely into its window.  Don’t 
forget that you can resize the window to any size. 

• Full Screen: This command blacks out your entire screen and displays your image in its 
full size.  You can zoom in/out as well.  Press Enter to skip to other open images.  When 
you want to get back to editing, press Esc. 

• Rulers: This command displays vertical and horizontal rulers, divided into pixels.  You 
may find them useful for certain types of editing. 

• Grids: Displays a grid with units divided by 100 pixels.  This grid won’t appear when you 
print your photo; it’s basically available as a guide if you want to break up your image 
into different segments. 

• Image Information: The Image Information Window displays various file data, such as 
the file name, width and height (in pixels), and resolution (DPI).  You can convert the 
size to inches or centimeters; this size is not fixed—it only reflects what the 
inch/centimeter measurement would be if you printed at the current resolution.  
Remember, on the print page, you can use the slider to adjust the print size.  Lastly, you 
can see a visual histogram of the color data. 

• Hide/Show Options: The bottom of the View menu gives you the option of showing or 
hiding each individual palette. 

 
 
Window Menu 
 
The Window menu has commands that organize how multiple pictures are sorted on the program 
desktop: 

 
• Tile: Organizes the open photos so that they’re assembled in a tile- or brick-like fashion. 
• Cascade: Stacks the image windows one atop the other.  When your open photos are 

arranged this way, they appear as if they’ve in a filing cabinet.  You can see the titlebars 
of each photo, but the one in front is the only one that you can actually see. 

• Close All: Closes all open photos.  If you’ve made edits and forgot to save them, you’ll 
have a chance to cancel the close operation. 

• Image Window List: The bottom of the Window menu lists each photo that you have 
open.  Click on any one to bring it to the top of the program desktop. 

 
 
Help Menu 
 
The Help menu contains a link to the index of the included Help file as well as an option to view 
the program’s splash screen (that cool image you see when you start the program). 



 

PhotoStudio Manual 
 

 - 27 - 

Tips & Tricks 
 
Here are just a few tips and tricks that you may find helpful: 
 

• Use the Control key on your keyboard to make multiple selections.  When opening 
photos or selecting them in an album, you can highlight multiple files at one time. 

• Before resizing your photo (“Image Size” in the Edit menu), make sure to view it in its 
actual view so you get a better idea of how it needs to be resized.  Select “Actual View” 
from the View menu. 

• Use the sample images that the program offers.  You don’t want to risk damaging your 
original photos, especially when you’re still learning the program. 

• Don’t be afraid to try new things with the program.  Remember that you can undo 
virtually anything. 

• Tool pop-ups.  Don’t forget to use them.  When you move your mouse over any tool or 
icon, a pop-up will appear with the tool name. 

• More along the lines of safety, it’s a good idea to maintain backups of your photos.  CDs 
in particular can store several photos.  Prices for CD-writing drives have dropped 
considerably, and many come included with new computers.  Backing up your photos on 
CD is a great way to catalog your files, too. 

• Save often.  We mentioned this in the beginning but it’s worth noting again. 
• Keep all of your photos together.  Store your photos in one folder.  It’s okay to have 

subfolders with a main folder, but keep everything where you can find it.  If you’re 
having trouble understanding how folders and subfolders can be created, you may want 
to pick up a book that introduces basic Macintosh concepts.  It’ll be worth the read.  
You’ll be amazed how much your understanding of all software applications will increase 
when you know more about the Macintosh OS. 

 

 

 



United States 
ArcSoft, Inc.  
46601 Fremont Blvd.  
Fremont, CA 94538 
Tel: 510-979-5599 
Fax: 510-440-7978 
www.arcsoft.com/en/support/  
support@arcsoftsupport.com 
   
Latin America 
E-Mail: latinsupport@arcsoftsupport.com   
  
Europe  
Unit 14, Shannon Industrial Estate 
Shannon, Co. Clare, Ireland 
Tel: +353 (0) 61-702087 
Fax: +353 (0) 61-702001 
eurosupport@arcsoft.com   
 
China  
5th Floor, International Garden 
160 Tianmushan Road, Hangzhou 310007 
Tel: +86-571-88210575 
www.arcsoft.com.cn/new/support/  
support@arcsoft.com.cn    
 
Japan  
Tel: 0570-06-0655 
www.arcsoft.jp  
support@arcsoft.jp    
 
Taiwan                                                                                           
Tel: +886 (0) 2-2506-9355 
Fax: +886 (0) 2-2506-8922 
www.arcsoft.com.tw  
support@arcsoft.com.tw 




